
 

 

Windows Mail: Setting up an account from start to finish 

Windows Live Mail is for Windows 7 and Vista. 

Click here: Windows Live Mail 2011  

Setting up your e-mail is a bit like setting up a new computer: You do it only once. After 

you configure your e-mail accounts in Windows Mail, you never have to hassle with it 

again—unless, of course, you open a new e-mail account. 

Windows Mail allows you to send and receive messages from multiple e-mail accounts. 

You can set up Windows Mail to work with many types of providers, from the biggest, 

most popular e-mail services all the way down to the smallest Internet service provider 

(ISP). 

Managing multiple e-mail accounts is simplified because each account in Windows Mail 

is organized in its own folder. You can check for messages from all your e-mail accounts 

at once by clicking a single button. But first, you'll need to set up each e-mail account one 

at a time in Windows Mail much as you did if you used Outlook Express. 

You can add multiple e-mail accounts in Windows Mail, and send and receive e-mail for 

all of them from one location just like you could setup different email accounts in 

Outlook Express by just clicking Tools…Accounts…ADD and enter the ISP(ex. 

Embarqmail.com), 

Type in the server incoming  pop.embarqmail.com  and the outgoing server 

smtp.embarqmail.com  and check the authentication box. 

In the user box type email address  jane34@embarqmail.com add the password you used 

for you embarqmail.com account 

Don’t be confused 

Before you set up Windows Mail, start by collecting the following information for each 

e-mail account. You will need to enter this information during the setup process: 

• Your e-mail address and password. 

• The type of e-mail server your e-mail service uses. 

• The address of the incoming and outgoing e-mail servers used by your e-mail 

provider. 

Most people know their e-mail addresses and passwords, but many people get confused 

when asked to enter information about e-mail servers. This is easiest if you gather some 



basic information from your e-mail provider before you begin adding accounts in 

Windows Mail. 

E-mail server types 

Windows Mail supports three types of e-mail servers. You don’t need to understand the 

details about these server types; you just need to find out which one your e-mail service 

uses both for incoming and outgoing e-mail: 

• Post Office Protocol 3 (POP3) servers. Most e-mail services and ISPs use this 

type of server, especially for personal e-mail accounts. They hold incoming 

e-mail messages until you check your e-mail, at which point they're transferred to 

your computer. Messages are typically deleted from the server when you check 

your e-mail. 

• Internet Message Access Protocol (IMAP) servers, such as AOL. These servers 

let you work with e-mail messages without downloading them to your computer 

first. You can preview, delete, and organize messages directly on the e-mail 

server. Copies are stored on the server until you delete them. IMAP is commonly 

used for business e-mail accounts. 

• Simple Mail Transfer Protocol (SMTP) servers. This outgoing mail server handles 

the sending of your e-mail messages to the Internet. An SMTP server handles 

only the outgoing e-mail, and is used in conjunction with a POP3 or IMAP 

incoming e-mail server. 

Incoming and outgoing e-mail servers 

Once you know the type of e-mail server used by each of your e-mail accounts, you must 

find out the address of its incoming and outgoing e-mail servers. During the setup 

process, Windows Mail requires you to enter the address of each e-mail server. There are 

only two types of incoming servers to choose from: POP3 or IMAP. 

Before you set up an e-mail account in Windows Mail, you need to know the address of 

the incoming and outgoing e-mail servers used by your e-mail provider  

POP3 is by far the most common type of incoming e-mail server for personal e-mail 

accounts. And SMTP is the only type of outgoing e-mail server that works with Windows 

Mail, so you normally don’t even need to check the outgoing server type with your e-mail 

provider. Practically all personal e-mail accounts—with the exception of web-based 

e-mail—use an SMTP server for outgoing e-mail. 

E-mail server addresses usually have the same format. Most ISPs (named “myisp” in this 

example) have server addresses like this: 

• Incoming server: pop.myisp.com (or imap.myisp.com, if they use an IMAP 

server) 



• Outgoing server: smtp.myisp.com 

You can usually substitute the name of your ISP in place of myisp in the example above. 

If this doesn’t work, check with your ISP. Questions about e-mail server addresses are 

among the most common inquiries e-mail providers get, so they usually have this 

information posted in the support section of their websites. 

Here are server addresses for some of the most popular e-mail services: 

• Yahoo!: pop.mail.yahoo.com (incoming) and smtp.mail.yahoo.com (outgoing) 

• AOL: imap.aol.com (incoming) and smtp.aol.com (outgoing) 

• Gmail: pop.gmail.com (incoming) and smtp.gmail.com (outgoing) 

• Embarqmail: pop.embarqmial.com and smtp.embarqmail.com  

Finally, you must know whether your outgoing e-mail server requires authentication, 

since there is a check box for this when you set up a new e-mail account in Windows 

Mail. If you can’t find out the answer from your e-mail provider, try sending a test 

message with the check box selected and another one with the check box cleared, to see 

which works. 

Note: Several years ago Comcast had Outlook Express users change their port from 25 to 

port 587.  If you’re using Win Live Mail and having trouble sending email, try changing 

the port from 25 to 587.  This has worked for some Win Live Mail folks with problems. 

Note2:Some e-mail services, such as Yahoo! Mail, require a premium subscription for 

POP3 access. 

Web-based e-mail and Windows Live Mail 

Many people want to know if they can send and receive Windows Live Hotmail in 

Windows Mail. The answer is ‘NO’ ,  Windows Mail does not support the HTTP servers 

used by Hotmail and other web-based e-mail services. 

However, you can set up Hotmail and other web-based e-mail accounts to work with 

Windows Live Mail. This allows you to store and read Hotmail messages even when you 

are not connected to the Internet. 

Windows Live Mail includes the familiar features of Windows Mail, the mail program 

included in Windows Vista, plus new features such as the ability to automatically enter 

the correct settings for e-mail servers used by popular e-mail services, including 

Windows Live Hotmail, Yahoo!, AOL, and Gmail. 

Windows Live Mail also works with e-mail services from other e-mail providers and 

ISPs, although you will have to configure those accounts manually. 



To download Windows Live Mail, go to the Windows Live Mail website.  

 

Step by step 

Once you have collected the required information for each e-mail account, you can start 

setting up Windows Mail. Here’s how to add an e mail account in Windows Mail: 

1. Open Windows Mail by clicking the Start button , clicking All Programs, and 

then clicking Windows Mail.  

2. Click the Tools menu, and then click Accounts. 

3. Click Add. 

After you click Add on the Internet Accounts screen, Windows Mail will ask what 

type of account you want to add 

4. Click E-mail Account, click Next, and then follow the instructions. 

After you are done entering all the information for one e-mail account, repeat the process 

for each e-mail account you want to set up, if you want to add more than the one account. 

Note 

During setup, you'll be asked to pick a display name. You might want to enter your actual 

name here rather than your e-mail address, since this is the name that recipients will see 

when you send them an e-mail message. 

Importing your e-mail, & contacts,into Windows Live Mail 

Ready to install Windows 7? Great! One thing you'll need to know before you begin, though, is 

that some familiar programs—like Outlook Express, Windows Mail, Windows Calendar, and 

Windows Address Book—aren't included in this version of Windows. But don't worry, you've 

got a couple of new options for getting to your e-mail, contacts, and calendars. 

You can use a free online service like Windows Live, which is a convenient way to go because you 

can access all your information from any computer with an Internet connection. 

But if you want to have all your data on your PC even when you're offline, you'll need to install a 

new desktop e-mail program, such as Windows Live Mail, part of Windows Live Essentials, a free 

suite of programs designed to link what you do on your desktop with what you do online.  

Once you've installed Windows Live Mail on your PC, you'll be able to import your existing e-mail 

messages, calendars, and contacts from Outlook Express (if you're upgrading from Windows XP or 

earlier) or Windows Mail (if you're upgrading from Windows Vista). You can also set it up to work 



with Hotmail and other e-mail providers—like Gmail, Yahoo! Mail Plus, or your Internet service 

provider (ISP)—to keep track of all your e-mail accounts in one place. To learn more about 

Windows Live Mail, see So long, Outlook Express! 

Making the switch to Windows Live Mail 

The steps you'll need to follow to get started with Windows Live Mail will depend on what type of 

Windows 7 installation you're doing—an upgrade or a custom installation. To find out more 

about installing Windows 7, see Installing and reinstalling Windows 7. To download Windows Live 

Mail, go to the Windows Live Mail website. 
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 If you're upgrading to Windows 7 from Windows Vista

Using the Upgrade option during Windows 7 installation will keep your files and settings from 

Windows Vista in place—including your e-mail, contacts, and calendars. Then, when you start 

Windows Live Mail for the first time, it will automatically import your data. 

If you're already using Windows Live Mail in Windows Vista, good news: You won't have to do 

anything special to get up and running after you finish upgrading to Windows 7. Just open and 

use it as you normally do. 

 If you're doing a custom installation of Windows 7

Choosing the Custom option during installation doesn't preserve your programs, files, and 

settings. That includes your e-mail, contacts, and calendars—whether you're using Windows Mail, 

Outlook Express, or another program. So you'll need to back up your e-mail, calendars, and 

contacts—along with any other files and settings you want to preserve—by copying them to an 

external hard disk or a USB flash drive. We recommend using Windows Easy Transfer, a free 

download, to do this backup. If you're upgrading from Windows XP, see Upgrading from 

Windows XP to Windows 7. If you're upgrading from Windows Vista, see Upgrading from 

Windows Vista to Windows 7 (custom installation). 

After Windows 7 is installed on your PC, you can use Windows Easy Transfer again to move all 

your files and settings back to your computer. Then, after you download and install Windows Live 

Mail, you can import your data. 

Top of page 

Importing e-mail and contacts into Windows Live Mail 

After you've moved your e-mail and contacts from the external hard disk or USB flash drive back 

to your PC and installed Windows Live Mail, you're ready to import your data into Windows Live 

Mail. 
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 To import e-mail

1. Open Windows Live Mail by clicking the Start button . In the search box, type Windows 

Live Mail, and then, in the list of results, click Windows Live Mail. 

2. Click the File menu, and then point to Import.  

3. Click Messages, and then choose the e-mail program from which you want to import 

e-mail messages. 

4. Click Next, and then follow the on-screen instructions. Your imported messages will appear 

in the folder list under Storage folders. 

 To import contacts

1. Open Windows Live Mail by clicking the Start button . In the search box, type Windows 

Live Mail, and then, in the list of results, click Windows Live Mail. 

2. In the lower-left corner of the Windows Live Mail window, click Contacts. 

3. Click the File menu, point to Import, and then click the type of address book that you want 

to import. 

If prompted, browse to the file that contains the contact information that you want to 

import, click it, and then click Open. 

 

 


